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Overview

This chapter covers the following topics:

e Introduction to Internet Services (OVIS) reporting
e Time periods, special terms, and statistics

e Provisioning the object model

e Integration with Network Node Manager (NNM)

e Ways to customize reports

e  Sources for additional information

Introduction to Internet Service Reporting

The Internet Services Report Pack 1.0 provides detailed information about services that are
critical to a successful business. It enables enterprises and service providers to monitor their
services, spot problem areas, and predict what performance will be like in the future.

Working together, the Internet Services Report Pack and the Internet Services Report Pack
Datapipe collect, aggregate, and analyze data maintained by OVIS Management Servers. In
terms of features and benefits, this is what the user can expect:

¢ Centralized reporting

¢ Centralized OVIS data warehousing
¢ Performance baselining

e Performance forecasting

¢ (Cross-domain reporting using data from other OpenView Performance Insight (OVPI)
reporting solutions

Internet Services offers the following perspectives on availability, response time, throughput,
and service level violations:

e Analysis of performance by day, with day-to-day comparisons
¢ Analysis of performance by month, with month-to-month comparisons

® Analysis of performance per 30-day rolling baseline




Introduction to Internet Service Reporting

In addition to examining performance by day, month, and rolling baseline, Internet Services
provides estimates for response time, throughput, and service level violations 30, 60, and 90
days into the future.

Folders and Reports

Internet Services 1.0 includes twenty interactive reports. Reports are contained in the

following folders:
¢ Detail
e Hot Spots

e Forecasts

e Summary

The detail folder contains the following probe and service reports:

¢ Daily Probe Type Detail

e  Monthly Probe Type Detail

e 30 Day Probe Type Detail

e Daily Service Detail

e Monthly Service Detail

e 30 Day Service Detail

The hot spots folder contains the following probe and service reports:
e Daily Probe Type Hot Spots

e Monthly Probe Type Hot Spots

e 30 Day Probe Type Hot Spots

e Daily Services Hot Spots

e Monthly Services Hot Spots

e 30 Day Services Hot Spots

The forecast folder contains the following probe and service reports:
e Probe Type Forecast

e Service Forecast

The summary folder contains the following probe and service reports:
e Daily Probe Type Summary

e Monthly Probe Type Summary

e 30 Day Probe Type Summary

e Daily Service Summary

e Monthly Service Summary

e 30 Day Service Summary




Chapter 1

Time Periods Defined

Aside from the forecast reports, every report in this package fits into one of these categories:

e Daily
e  Monthly
e 30day

The daily report begins with statistics for yesterday and allows you to compare yesterday’s
statistics to performance over the preceding 30 days. The tables at the top of the report look at
data for the selected day, while the graphs below let you see a full 30 days of data.

The monthly report lets you see what the trend has been for the past 12 months. This report
provides:

e An aggregation for month-to-date (the beginning of the current month until yesterday)
e An aggregation for previous calendar months, up to a maximum of 12 months

The 30 day report aggregates data for the preceding 30 days. The tables at the top look at
totals and averages for a rolling 30 day baseline, while the graphs below provide data for each
day within the rolling 30 day baseline.

Terms Defined

Term Definition

Customer The customer as defined in the OVIS Server; the name
of the customer for whom services are being monitored.

OVIS test One execution of a simulated service from one probe
system to one target.

Probe System Also referred to as a probe. The system that contains
software that initiates the simulated service, measures
the results, and sends the results back to the OVIS
server.

Probe Type Also referred to as Service Type or just Service in the
OVIS system. A simulated network business activity
such as HTTP, FTP, DNS, etc.

Service Also referred to as Service Group in the OVIS system. A
grouping of measurements of a single service or probe
type that have common service level objectives.

Service level violation The number of tests that exceeded a threshold as
defined by the OVIS system user.

Target The target of the simulated service. This could be a
URL, a DNS server, an FTP server, etc.




Introduction to Internet Service Reporting

Statistics Defined

Statistic Definition

Availability The percentage of tests that were successful; serves as
an estimate of service availability.

Response time The response time measured by probe systems for
successful OVIS tests. The response time shown in
Daily reports, and in the graphs of 30 Day reports, is the
highest (worst) hourly average for each day. The
response time displayed in Monthly reports, and in the
selection tables of 30 Day reports, is the average of the
highest hourly average for each day. The graphs in
Monthly reports also show the maximum of the daily
highest hourly averages during the month.

Service Level Violations | A count of the number of tests that exceeded the service
level objectives specified in the OVIS system.

Throughput The throughput measured by probe systems for
successful OVIS tests. The throughput displayed in
Daily reports, and in the graphs of 30 Day reports, is the
lowest (worst) hourly average for each day. The
throughput displayed in Monthly reports, and in the
selection tables of 30 Day reports, is the average of the
lowest hourly average for each day. The graphs in the
monthly reports also show the minimum of the daily
lowest hourly averages during the month.

Note: Not all OVIS tests measure throughput.

Provisioning and the Object Model

There is no need to provision Internet Services 1.0. This is because OVPI uses customer
information maintained by the OVIS Management Server to populate the appropriate table in
the Common Property Tables package. The customer data in that table is used by Internet
Services 1.0 to populate reports with customers. As a result:

e OVPI knows which services belong to each customer
e OVPI knows which probe types are used by each customer

Installing Internet Services 1.0 modifies the object model maintained by OVPI. The following
objects are added to the customer view model:

e Service

e QVIS Probe type

OVIS customers are viewable from the Management Console by doing the following:
Select Objects > View > Change View > Customers

You can view any report in the Internet Services 1.0 package by highlighting a customer and
selecting one of the reports listed under Object Specific Reports. For example:

Customer XYZ > Object Specific Reports > Daily Probe Type Hot Spots

10
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The report that opens will be constrained, containing data for customer XYZ only. You can
launch summary or detail reports by selecting a specific probe type or service, as follows:

XYZ > Probe Type N > Daily Probe Type Detail Report
Customer XYZ > Service N > Daily Service Summary Report

The report that opens will be constrained, containing data for N probe type, or N service, for
customer XYZ only.

Integration with NNM

If your OVPI server and your NNM server are integrated, you can launch the reports in
Internet Services 1.0 directly from NNM. The reports in Internet Services 1.0 (as well as the
reports in any other OVPI report packs you are using) will be listed in the Report Launchpad
window. The NNM operator can open this window from:

e NNM maps (ovw)
e NNM Extended Topology dynamic view
e NNM alarm browser

OVIS Management Servers are already integrated with NNM and the NNM alarm browser.
For this reason, Internet Services 1.0 does not include a thresholds sub-package.

Ways to Customize Reports

The contents of a report can be customized by applying group filters, by editing parameters,
and by editing tables and graphs. While service providers, or any organization that wants to
share reports with customers, use group filters to create customer-specific reports, any user
can apply constraints to a report, edit a table, or edit a graph. For details about view options
for tables and graphs, see Chapter 8, Editing Tables and Graphs.

Group Filters

If you intend to share your reports with customers, you will need customer-specific reports.
Creating customer-specific reports involves the following tasks:

e Importing custom property information (customer names and device locations) using
Common Property Tables

¢ C(Creating a group account for all of the users affiliated with a particular customer
e Creating a group filter for the group account

For more information about creating filters for group accounts, refer to the Performance
Insight 5.0 Administration Guide.

11
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Editing Parameters

Editing a parameter applies a constraint. The constraint eliminates data you are not
interested in seeing. For example, if you edit the Customer Name parameter, data for every
customer except the customer you typed in the Customer Name field would drop from the
report. Internet Services 1.0 supports the following parameters:

e Customer

e Service

e  Probe Type
e (Cust_id

If you are using the Web Access Server to view reports remotely, edit parameters by clicking
the Edit Parameters icon at the bottom right-hand corner of the report. When the Edit
Parameters window opens, enter the constraint in the field and click Submit.

If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the
Modify Parameter Values window opens, click the Current Value field. Type a new value and
click OK.

Sources for Additional Information

This user guides provides samples of some of the reports, but not all of them. The demo package
that comes with Internet Services 1.0 contains one sample of every report in the package. If you
have access to the demo package and you want to know what fully-populated reports look like,
install the demo package. Like real reports, demo reports are interactive. Unlike real reports,
demo reports are static.

The following documents are related to Internet Services 1.0:

e [Internet Services Report Pack 1.0 Release Statement

e Common Property Tables 3.5 User Guide

e NNM / Performance Insight Integration Module 2.0 User Guide
e QOVIS 5.0 Custom Probes API Guide, September 2003

e RNS 7.0 Release Notes, November 2004

Manuals for the core product, OVPI, and manuals for the reporting solutions that run on
OVPI are posted to the following site:

http:/www.hp.com/managementsoftware

Select Support > Product Manuals to open the Product Manual Search page. Manuals for OVPI are
listed under Performance Insight. Manuals for report packs, datapipes, and NNM components
(SPIs and correlators) are listed under Reporting and Network Solutions.

The manuals listed under Reporting and Network Solutions indicate the month and year of
publication. If a user guide is revised and reposted, the date of publication will change even if
the software version number does not change. Since we post revised manuals on a regular
basis, you should search this site for updates before using an outdated manual.
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Package Installation

This chapter covers the following topics:
¢  Guidelines for a smooth installation
e Installing Internet Services 1.0

e Creating OVIS collections

e Accessing deployed reports

e Seeing performance data in reports

e Package removal and OVIS system removal

Guidelines for a Smooth Installation

Each reporting solution that runs on OVPI consists of a report pack and one datapipe, or
sometimes a report pack and multiple datapipes. When you install the datapipe, you configure
OVPI to collect a specific type of performance data at a specific polling interval. When you
install the report pack, you configure OVPI to summarize and aggregate performance data in
a specific way.

The RNS 7.0 CD includes components for NNM as well as OVPI report packs. If you or
someone else has already extracted OVPI packages from this CD, every OVPI report pack,
including the Internet Services Report Pack 1.0, has been copied to the Packages directory on
your system and is ready to install, using the instructions in this chapter.

If you have not extracted packages from the RNS 7.0 CD and you need help, see the package
extraction procedure later in this chapter.

Prerequisites

Make sure the following software is already installed before installing Internet Services:
e OVPI5.0

* Any available service pack for OVPI 5.0

e Common Property Tables 3.0 or higher

13



Installing Internet Services 1.0

Upgrading Common Property Tables

If you are running an older version of Common Property Tables, you must upgrade that
package to version 3.0 or higher. If you are not running any version of Common Property
Tables, there is no need to do anything, since Package Manager will install the latest version
of Common Property Tables for you, automatically.

Do not install an upgrade for Common Property Tables and other packages at the same time.
Install the upgrade package for Common Property Tables and only the upgrade package for
Common Property Tables. For more information about installing and using Common Property
Tables, refer to the Common Property Tables 3.5 User Guide.

Distributed Systems

If your system is distributed, the installation procedure is more complicated. Following is a
summary of the installation procedure for a distributed system:

1 Verify that every server is running OVPI 5.0 and all available service packs for OVPI 5.0.
2 Disable trendcopy on the central server.
3 Upgrade Common Property Tables (2.2-t0-3.0 or 3.0-to-3.5).
4 Install Internet Services 1.0 on the central server; deploy reports.
5 For each satellite server:
e Upgrade Common Property Tables
e Install these packages:
— Internet Services Report Pack 1.0
— Internet Services Report Pack Datapipe 1.0
6 Re-enable trendcopy on the central server.

When installation is complete, you must set up connections with satellite server databases,
configure trendcopy pull commands, and switch off aggregations at each satellite server.
These steps are covered in Chapter 3, Distributed Systems.

Installing Internet Services 1.0

This section covers the following tasks:
e Task 1: Extract packages from the RNS CD
e Tagk 2: If necessary, upgrade Common Property Tables
e Task 3: Install these packages:
— Internet Services 1.0

— Internet Services Datapipe 1.0

14



Task 1:

Task 2:

Task 3:

Chapter 2

Extract packages from the RNS CD
1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.
Windows: Select Settings > Control Panel > Administrative Tools > Services.
UNIX: As root, type one of the following:
HP-UX: sh /sbin/ovpi_timer stop
Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the RNS 7.0 CD. On Windows, a Main Menu displays automatically; on UNIX,
mount the CD, navigate to the top-level directory for the CD drive, and type the setup
command.

4 Select OVPI report packs by typing 1 in the choice field and pressing Enter. The install
script displays a percentage complete bar. When extraction finishes, the install script
starts Package Manager. The Package Manager welcome window opens.

If you navigate to the Packages directory on your system, you will see the following folders
under the Internet Services folder:

e Internet_Services.ap

e Internet_Services_Demo.ap

Installing the demo package is optional. You may install the demo package and only the demo
package, or you can install the demo package along with everything else.

Upgrade to Common Property Tables 3.0 or higher

If you are running Common Property Tables 2.2, you must upgrade to version 3.0. If you are
running version 3.0, you have the option of upgrading to version 3.5. Observe these rules:

e Do not install any other package with the upgrade package; install the upgrade package
and only the upgrade package.

e  When prompted to accept or disable the option to Deploy Reports, accept the default. If
you do not deploy reports, you will not have access to the forms that come with Common
Property Tables.

¢  When the install finishes, click Done to return to the Management Console.

If you need help with the upgrade, refer to the Common Property Tables 3.5 User Guide.

Install the report pack and the datapipe

1 From the Management Console select Tools > Package Manager. The Package Manager
welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install. Approve the default installation directory or use the browse feature to select
a different directory if necessary.

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports;
accept the default for application server name and port. Type your username and
password for the OVPI Application Server.

5 Click Next. The Package Selection window opens.

15



Defining OVIS Collections

10

11
12

Click the check box next to the following package:
Internet Services 1.0
Internet Services Datapipe 1.0
Internet Services Demo (optional)

Click Next. The Type Discovery window opens.

Disable the default to run Type Discovery immediately after package installation.

) The Internet Services package does not require Type Discovery.

However, if you are installing other report packs in addition to
Internet Services, you may need to run Type Discovery for those
packages.

Click Next. The Selection Summary window opens.

Click Install. The Installation Progress window opens and the install process begins. When
the install finishes, a package install complete message appears.

Click Done to return to the Management Console.
Restart OVPI Timer.
Windows: Select Settings > Control Panel > Administrative Tools > Services.
UNIX: As root, type one of the following:
HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

When the Internet Services Report Pack and the associated datapipe are installed, your next
task is to define OVIS collections.

Defining OVIS Collections

Follow these steps to define OVIS collections:

1

2
3
4

o

Start the Management Console.
Click the Systems icon located on the left-hand side of the Management Console.
Expand the information under the OVPI system by clicking “+”.

Right-click the Databases folder icon and select Add Database. The Add Database Wizard
opens.

Click Next.

Select Generic Supported Database and click Next. The Database Connection Information
window opens.
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7 Add the following database connection information in the window shown below:

Hostname — Either the host name or the IP address of the OVIS server
Port — The TCP/IP port number

>»

The port number for an OVIS system installed on Oracle is
normally 1521. If this number is not valid, check with your Oracle

DBA. The procedure for determining the SQL server port number is
provided below.

Description — Must include either “OVIS” or “ovis” to enable collection of OVIS data
Vendor — Select the database vendor for the OVIS system

Database Instance — Specify OVOPS for SQL server; reporter for Oracle

Database Username — Username with access to the OVIS database

Password — Database password

8 Click Next.

9 Type a unique, identifying System name and (optional) description and click Next. The

Summary window opens.

10 Click Finish.

Database Connection Information

OpenView

Enter the database connection information

Hosthame I

Port fo

Description I

“endar I

Databasze Instance I

Databasze Username Idsi_dpipe

Pazswoard I

= Back | [Mext = { cancel
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Accessing Deployed Reports

Determining the Port Number

Follow these steps to determine the port number for a SQL Server OVIS system:
1 Execute svrnetcn.exe from the command line. The SQL Server Network Utility opens.
2 Verify that TCP/IP is selected in the Enabled Protocols section.

3 Click Properties. The port number appears in the pop-up window.

Collecting Data from OVIS

Once the OVIS system has been added as a supported database, the Internet Services
Datapipe will begin collecting data automatically. The initial collection may take a long time.
This is because OVIS systems store data for a number of days. If the OVIS system is using the
default, data will be stored for 7 days. Subsequent collections will complete much faster, since
only incremental data will be collected.

If you wish to stop collecting from an OVIS system, do one of the following:
e Using the Management Console, delete the system as a supported database.

e EKEdit the database description, removing any reference to “OVIS” or “ovis”.

Accessing Deployed Reports

When you installed the Internet Services package, you enabled the Deploy Reports option. As
a result, the reports in this package (as well as any forms that come with the package) were
deployed to the OVPI Application Server. Once reports reside on the OVPI Application Server,
you have two ways to view them:

e (OVPI clients
e  Web browser

If the client components are installed on your system, you have access to Report Viewer,
Report Builder, and the Management Console. If the client components are not installed on
your system, using a web browser is the only way you can view reports.

For more information about the client components, refer to the Performance Insight
Installation Guide. For more information about the Management Console, including how to
use the Object/Property Management view to launch reports specific to a selected object, refer
to the Performance Insight Administration Guide.

Seeing Performance Data in Reports

If you are accustomed to working with other OVPI packages, you know that Near Real Time
reports are the first reports to populate with data. Since there are no NRT reports in this
package, you will not see report data right away. Since processing occurs at night, the earliest
data will appear tomorrow.

In the days immediately following installation, you will see some data in daily reports, 30 day
reports, and monthly reports.

18
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e In daily reports, you will see totals and averages for each day for which you have data.

¢ In the 30 day reports, you will see aggregated data representing all the days for which you
have data.

¢ In the monthly reports, you will see month-to-date aggregations in the selection tables.

If the data you collected includes data for any part of the previous calendar month, the graphs
in the monthly reports will be populated. If the data you collected has no data for the previous
month, the graphs will remain empty until you begin collecting data on the first day of next
month.

Forecast reports are generated from a rolling baseline. Even though forecast reports will
contain data before the initial baseline (30 days) is complete, reliable forecasting data will not
be available until the initial baseline is complete.

Package Removal and OVIS System Removal

Task 1:

Follow the steps under Task 1 to uninstall Internet Services. Removing Internet Services will
automatically remove the datapipe. Task 2, which tells you how to remove an OVIS system
defined as a Generic Supported Database, is good practice; however, performing this task is
not absolutely necessary.

Uninstalling Internet Services

1 Log in to the system. On UNIX systems, log in as root.
2  Stop OVPI Timer and wait for processes to terminate.
Windows: Select Settings > Control Panel > Administrative Tools > Services.
UNIX: As root, do one of the following:
HP-UX: sh /sbin/ovpi_timer stop
Sun: sh /ete/init.d/ovpi_timer stop
Start Package Manager. The Package Manager welcome window opens.
Click Next. The Package Location window opens.
Click Uninstall.

Click Next. The Report Undeployment window opens.

N o a b~ W

If Internet Services reports were deployed from this server, accept the defaults for
Undeploy Reports, Application Server Name, and Port. If Internet Services reports were
not deployed from this server, clear the check box and skip to step 9.

8 Type the username and password for the OVPI Application Server.
9 Click Next. The Package Selection window opens.
10 Click the check box next to the following package:
Internet Services Report Pack 1.0
11 Click Next. The Selection Summary window opens.

12 Click Uninstall. The Progress window opens and the removal process begins. When the
uninstall process is complete, a package removal complete message appears.

19



Package Removal and OVIS System Removal

Task 2:

13 Click Done to return to the Management Console.

14 Restart OVPI Timer.

Windows: Select Settings > Control Panel > Administrative Tools > Services.
UNIX: As root, do one of the following:
HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Removing any OVIS systems defined as a Generic Supported Database

1
2
3
4

Click the Systems icon on the left-hand side of the Management Console.

Select the local system. OVPI and generic databases appear in the main window.
Right-click the OVIS system and select Delete System...

Click Yes in the pop-up window.

The OVIS system is now removed.

20



Distributed Systems

This chapter covers the following topics:
e Verifying correct package installation
¢ Configuring the central server

e Configuring satellite servers

Verifying Correct Package Installation

If you intend to run Internet Services 1.0 as a distributed system, you must configure all of
the servers in the system. Before doing that, verify that you have the right packages installed
on each server.

Packages on the Central Server

e Internet Services Report Pack 1.0; with reports deployed
e Common Property Tables 3.0 or 3.5; with forms deployed

Packages on Each Satellite Server

e Internet Services Report Pack 1.0
e Common Property Tables 3.0 or 3.5
¢ Internet Services Report Pack Datapipe 1.0

Typically, the central server does not poll. If you want the central server in your system to
poll, install the datapipe on the central server. If desired, you may view reports on satellite
servers, which we refer to as local reporting. If you want local reporting, deploy reports from
each satellite server.

Configuring the Central Server

To configure the central server, perform the following tasks:
e Task 1: Set up connections with satellite server databases

e Task 2: Configure trendcopy pull commands

21



Configuring Satellite Servers

Task 1: Set up connections with satellite server databases

w

4
5
6
7

Start the Management Console.
Click the Systems icon on the lower left. The System/Network Administration pane opens.

Right-click the Databases folder. When prompted, select Add OVPI Database. The Add
Database Wizard opens.

Click Next.

Type the hostname and port number for the database you want to add; click Next.
Review the Summary. Repeat Steps 4 and 5 for each additional database.

Click Finish when you finish adding databases.

Task 2: Configure trendcopy pull commands

1

Open this file:
SDPIPE_HOME/scripts/Internet_Services_Hourly.pro
For block2, remove the “#” from the begin and end lines.

Modify the trendcopy commands so that each command includes the correct server name
for the central server and for each satellite server.

If necessary, add more commands.

Configuring Satellite Servers

To configure a satellite server, switch off aggregations above the hourly level. Do this by
editing the $DPIPE_HOME/lib/trendtimer.sched file. Comment out the line
referencing Internet_Services_Daily.pro.

22



Hot Spots

Hot Spots reports improve your visibility into the services and probe types that are
experiencing the worst performance. Each report pinpoints the 10 services or 10 probe types
with the highest service level violations, lowest availability, highest response time, and lowest
throughput.

The Hot Spots folder contains three probe type reports and three service reports:
e 30 Day Probe Type Hot Spots

e Daily Probe Type Hot Spots

e Monthly Probe Type Hot Spots

e 30 Day Services Hot Spots

e Daily Services Hot Spots

e  Monthly Services Hot Spots

If you want to watch for problem areas as they arise, use the daily reports. As soon as you spot
a problem area, you can investigate it further by using the summary and detail reports in the
other folders.

The monthly reports show (1) the month-to-date totals and the month-to-date averages for the
current month and (2) the complete monthly totals/averages for previous months. Use these
reports to compare actual performance to monthly Service Level Agreements.

The 30 Day reports provide an aggregated view of recent performance. These reports smooth
out daily anomalies, while crossing the boundary between two months.

See below for samples of the following reports:
e 30 Day Probe Type Hot Spots
e 30 Day Services Hot Spots
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30 Day Probe Type Hot Spots invent

The 30 Day Probe Type Hot Spots Report provides liste of probe types that had the worst performance (zervice level violations,
awvailahilty, responsze time and throughput) far the preceding 30 days.

Customer
All Customers -
ACME
Internet Senvices, Lid.
Web Manitoring Corp. ﬂ
Sevice Level Violations Availability
Most Service Level Violations Warst 30 Day Availability (Percent)
Probe Type Violations Probe Type Availability
1 HTTF 25,255 1 opBc 0.0
2 EX.CHANGE 24,942 2 RADIUS 0.0
3 RADIUS 19,423 3 ExCHAMGE 5.3
4 HTTP_TRAMNS G839 4 DHCFR 53.4
o LHCF 2,276 o HTTFS 539
E apBc 1,380 E AP 52.1
T STREAMING_MEDIA 1,268 T HTTP_TRANS G35
=] IMAPS G256 =] HTTF 7249
3 nAF 2495 3 nAF B2.3
10 CHE 212 10 MWAILREOUMD TRIF 929
Response Time Throughput
Worst 30 Day Average (Seconds) Worst 30 Day Average (Bytes / Second)
Probe Type Response Time Probe Type Throughput
1 STREAMING_MED1A 22.91 1 NTF 023
2 HTTF 15.04 2 IChiP 0.4
3 AP 5.21 3 HNHTF oG9
4 MAILROUNDTRIP 534 4 LHCP oar
5 HTTP_TRANS 4.0z 5 It AP S 2.0z
E SAFP_BASIS 1.37 E STREAMING_MEDIA 2487
T SCRIFT 1.24 7 AP 270
g FOPz 1.27 g SMTP 473
=] Ihd AP 1.3 =] HTTPS 16.39
10 FTF 1.02 10 HTTF 29.04
Fesponse time displayed is the average of the daily Thmoughput displayed is the awerage of the daily
maximum hourky awerages owverthe previous 30 days. minimum hourly avarages ower the previous 30 days.
M
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Internet Services (JB

30 Day Services Hot Spots invent

The 30 Day Services Hot Spots Report provides lists of services that had the worst performance (zervice level violations, availakility,
responze time and throughput) for the preceding 30 days.

customer
ACME
Internet Sermrices, Lid.
Mieb Monitaring Carp.
HE, Incorparated

Sevice Level Yiolations Availability

Most Service Level Violations Worst 30 Day Availability (Percent)

Service Violations Service Availability
1 ACME HTTF1 25,147 1 ACMWE ODBC 0.0
2 ACME DHCP 2,276 2 Smith DHCP 26.2
3 ACME HTTFZ 233 3 ACME DHCP 728
4 ACME DHS 188 4 ACME HTTPZ arz
& WINSATS FTP G 5 ACME HTTPA ara
5] ACME ICMP u] B ACME DMNS t=]
T ACME ODBC u] 7 ACME ICMP t=]
g Smith DHCP u] o] WINSATS FTP t=]

Response Time Throughput

Worst 30 Day Average (Seconds) Worst 30 Day Average (Bytes / Second)

Service Response Time Service Throughput
1 ACME HTTPZ 18.04 1 ACME ICHP 029
2 ACME HTTPA 1772 2 Smith DHCP 0.57
3 WINEATS FTP 1.54 3 ACME DHCP 0.a85
4 Smith DHCP 085 4 ACMWE HTTPRZ 420
4] ACMWE DHCP oFr 4] ACME HTTPA 451
B ACME DHS 0.4 B WINSATS FTF 114.00
T ACME ICMP 0.0z

Fesponse time displayed is the awerage of the daily Throughput displayed is the average of the daily
maximum hourly averages overthe previous 30 days. minimum hourly averages over the previous 30 days.
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Summary Reports

The reports in the summary folder provide statistics at the service and probe type level. The
summary folder contains the following reports:

e 30 Day Probe Type Summary
¢ Daily Probe Type Summary

e Monthly Probe Type Summary
e 30 Day Service Summary

e Daily Service Summary

e Monthly Service Summary

Summary reports provide a historical context for hot spots reports. For example, if a report in
the Hot Spots folder has just alerted you to a problem, you can use the corresponding
summary report to find out whether you are dealing with an unusual situation that could not
have been predicted or a trend that has been steadily worsening over time.

In a summary report, you drill down from a customer to a list of services or probe types
associated with the customer. For each probe type or service, you have the following
aggregated statistics:

e Service level violations
e Availability

e Response time

¢ Throughput

The figures in the probe type/service selection table aggregate data for every probe type/target
associated with each probe type or service. Beneath the probe type/service table are graphs for
service violations, availability, response time, and throughput. Use these graphs to see what
the trend has been like for the past 30 days and the past 12 months.

See below for two sample reports, the Daily Probe Type Summary and the Daily Service
Summary.
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Internet Services

Daily Probe Type Summary

[}

invent

The Probe Type Summary Report presents performance statistics for probe types associsted with a given customer for the selected
day. By selecting a particular probe type, the user can see itz service level vialations, availskilty, responze tirme and throughput over

the preceding 30 days.
Customer Day
All Customers s Marzh 8, 2004
ACME Marzh 7, 2004
Internet Senrices, Lid. March 6, 2004
Web Monitering Coarp. j Marzh &, 2004
Probe Type Performance
Sorted by number of service level violations
Probe Type SE;':;;E::EI Availability Responsge Time
HTTF R 1l S & - B 2097
EXCHANGE . 4 o
RADIUS 2/ H 1 B
HTTP_TRANS IR R . L 237
DHCF T e 0.70
DNS 10 . mass 065
FTF 4 - Mmoo 114
ODEC o e
HTTFS o e 0.1
CTODCARAIRISE RACTI N _ _ T RT
Service Level Yiolation Availability
HTTP HTTP

Humber of Violation
Percent

ul
Feb 05

ol
Feb 02 Feb 15 Feb 22 Feb 20 hdar0?

@Daily Sevice Level Violations

Feb 15  Feb 22
B vait ability
B un availability

Throughput
£1.68 =
T455
1.02
5642 o

1748 j

Feb 28 har a7y
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M\/\/\/\/\/\/\/\/\/\/\/\/\W\/\/\

Response Time Throughput
HTTP HTTP
20007 70.007
24007 Essoot
! 5 !
® o
T 13.001 F 200t
8 ] 'g;-* T
2 ] ]
B 12.00 22500
! i !
&.007 214001
o + + + + o : + + +
Feb0S  Feb 15  Feh2?  Feb23  Mar7 Feb0S  Feh15  Feb2?  Feb23  MarO7

b3z Hourly Awerage BT hin Hourly Average Throughput

Throughput displayed is the minimum hourly

Response time displayed iz the maximum hourly
awerage per day.

awerage per day.
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Daily Services Summary invent

The Services Summary Repoart presents performance statistics for services associated with a given customer for the selected day.
By zelecting a particular service, the uzer can see itz zervice level vilations, availability, responze time and throughput over the last
30 days.

Customer Day
ACME March 2, 2004 i’
Internet Senvices, Lid. March ¥, 2004
reb Monitaring Corp. harch &, 2004
HAE, Incarparated harch &, 2004 ll

Service Performance
Sorted by number of service level violations

Service Level

Service Violations Availability Responge Time Throughput
ACME HTTP1 [mmesa sess 18,57 451
ACME DHCP = 7282 0.73 0.87
ACME DNS 2 . oo 0.85
WINSATS FTP 4 [ omooo 184 20.07
ACME HTTPZ 2 I eazm 1808 472
ACME ODBC 80 [T
Smith DHCP 80 [mEmmEsl 1.08 0.52
ACME ICMP N [ < 0.0% 0.34

Service Level Yiolation Availability
ACME HTTP1 ACME HTTP1
200
=
2 720
B
= E o
S sa0 3
: ;
= 360
=]
£ 150
= 0

o FebOS  Feb 1S  Feb2Z  Feb20  Mar07

FebD3  Feb 15  Feb2?  Feb20  Mari7 W cvaitability

B aily Sevice Level Violations B Un avail ability
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Response Time
ACME HTTP1

0007

24.007

Seconds
Mmom
o o
o 2

G.00T

il + + + +
Feb 02 Feb 15 Feb 22 Feb 28 hdar 07
hlax Hourly Awerage BT

Fesponse time displayed is the maximum hourly
duerage per day.

Throughput
ACME HTTP1

G.00T

E 4807
=]

o
$aE0t

=

Sranr
;]

@
21207

il + + +
Feb 02 Feb 15 Feb 22 Feb 29
Min Hourly Awerage Throughput

Throughput displayed iz the minimum hourhy
awerage per day.

hdar a7
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Detail Reports

The reports in the detail folder allow you to find out which OVIS tests are experiencing
problems and whether or not the problem is typical or unusual compared to past performance.
The detail folder contains the following probe type and service reports:

e 30 Day Probe Type Detail
¢ Daily Probe Type Detail

e  Monthly Probe Type Detail
e 30 Day Service Detail

e Daily Service Detail

e Monthly Service Detail

All detail reports begin with a list of customers. Select a customer to display a list of services/
probe types, sorted by violations highest to lowest, with data for the following statistics
aggregated over all OVIS tests:

e Service level violations
e Availability

e Response time

¢ Throughput

By selecting a particular service or probe type, you can display (1) a list of the associated
probe system/target combinations, sorted by violations highest to lowest, and (2) performance
data for each combination. The graphs below the second table are linked to the item selected
in the second table. These graphs provide test-level trending analysis, allowing you see
whether violations, availability, response time, and throughput are improving or getting
worse.

) All OVIS tests calculate response time, but not all OVIS tests calculate
throughput. If Null shows up in a table or graph that reports throughput,
none of the OVIS tests that target this particular service calculates
throughput.

See below for samples of all six reports in the detail folder.
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30 Day Probe Type Detail invent

The 30 Day Probe Type Detail Report presents perfarmance statistics, calculated over the previous 30 days, for probe types
azzociated with a given customer. By selecting a particular probe type, the user can zee performance statisticzof the probe and
target combinations far tests of the selected type. By selecting a probe and target combination, the daily service level vialations,
availabilty, rezponze time and throughput for the selected test will be dizplayed for the preceding 30 days.

Customer
ACME
Internet Senrices, Lid.
Meb honitering Corp.
HE, Incorporated

Probe Type Performance
Sorted by number of sendAce level violations

Service Level

Probe Type Violations Availability Rezponse Time Throughput
HTTF a7z 17.70 4.52
DHCP 0.7z 0.9z

DHNS 185 049

FTF 1.54 114.00

onBeC

IChP 0.03 0.z9

Probe System / Target Performance Breakdown
Sorted by number of service level violations

Probe System Short Target Hame SE;‘:::;L‘::EI Availability RE?::::SE Throughput
winzatd.esr.hp.com v hp.com/s _ a7r.0 16.50 4.83
winzsatd.esr.hp.com VAR TSN 0 my _ arz2 2445 284
winzsatd.esr.hp.com athp.hp.com/ _ 975 14.02 4.73
winsats. esr.hp.com vty ahoo. comd 233 ar2 18.04 420

winsats athp.hp.coms -z 0@ 10.76 553

winzats v yahoo coms _ _ 582 1237
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Service Level Yiolation

- - oA ]
o] [an ) % o
[} ] (]

Number of Violation
[m1]
-

Fab 12 Fab 20 Fab 27 hdar 05

@Seuice Lewel Violations

Response Time
40.007

F2.007

L
ha
o
=]

Seconds
o
o
o

g.007

Fab 13 Feb 20 Fab 27 har 05
hdax Hourhy Awrerage RT

Responsa time dizplayed iz the maximum hourly
werage per day.

Chapter 6

Availability

Percent

Feb 13 Feb 20 Feb 27 hdar 05

B 2vailability
B U avail ability
Throughput
7007
-
T 5,60
=]
g
& az0f
™
2
22801
"]
%1.40--
0

Feb 13 Feb 20 Fab 27 hdar 05
Min Hourly Average Throughput

Throughput dizplayed iz the minimum hourhy
Fverage per day.
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Daily Probe Type Detail

(/3

invent

The Probe Type Detail Repart presents performance statistics far probe types associated wwith & given customer for the selected day.
By zelecting a particular probe type, the user can see performance statistics of the probe and target combinations for tests of the

selected type. By selecting a probe and target cormbination, the zervice level violations, availakilty, response time and throughput for
the selected test will be displayved for the preceding 30 days .

Customer
ACME

Internet Services, Lid.

Web Monitaring Corp.

Probe Type

HTTP
DHCP
DNS
FTP
ODBC
ICMF

Probe System

winsath.esr.hp.com
winsath.esr.hp.com
winsath.esr.hp.com

winsath.esr.hp.com

A, Incarporated

Probe Type Performance
Sorted by number of service level violations

Service Level
Violations

||L .:I||

Availability

Day
March 2, 2004
March 7, 2004
March &, 2004
March 5, 2004

Response Time

18.52
oo
0.94
1.21

0.0z

Probe System / Target Performance Breakdown
Sorted by number of service level violations

Short Target Hame

VAR TSN G Oy
v hpcomd
athp.hp.coms

v wahoo. com/

Service Level
Violations

2

Availability

Response
Time
24493
17.68
16.08
18.05

=
-

Throughput

.56
1.02

2007

024

Throughput

4.21
437
4.0
4.72
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Service Level Yielation Availability
200
=
3 240
"
= i
& 180 g
s T
= 120 e
-
£
2 &0
0 Feb 13  Feb20  Feb27  Mar0s
Feb 13  Feb20  Feb27  Mar0s B covaitability
B paily Sevice Level Violations B unavailability
Response Time Throughput
20,007 5.007
24,001 T 4.00]
E E
i &
= 15.00 2.001
= i
3 2
m E
2 12.00 =200
a J
6.001 Emn-
o 0

Feb 13 Feb 20 Feb 27 hdar 05 Feb 13 Feb 20 Feb 27 hdar 05

hd 3z Hourly Awerage BT hin Hourly Awearage Throughput
Fesponse time displayed isthe maximum hourly

Throughput displayed iz the minimum hourly
Juerage per day.

Juerage per day.
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Monthly Probe Type Detail
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The Probe Type Detail Report presents performance statistics for probe types associsted with a given customer for the selected
morth. By selecting a particular probe type, the user can see performance statistics of the probe and target combinations for tests of
the selected type. By selecting & probe and target combination, the morthly service level violations, availabilty, response time and
throughput for the selected test will be dizplayed far the preceding 12 maonths. Data for the current month covers results from the first
of the morth through yesterday .

Customer
ACME

Month
harch, 2004

Internet Senices, Lid. February, 2004
January, 2004

Lecember, 2003

ek Manitaring Carp.
SE, Incarparated

L

Probhe Type Performance
Sorted by number of service level violations

Service Level

Probe Type Violations Availability Response Time Throughput
HTTF 025 18.70 463
BHCP 0.74 0.3
LHE 0.55
FTP 1.66 124.87
abBC
ICh P 0.0z 0.2a
Probe System / Target Performance Breakdown
Sorted by number of service level violations
Probe System Short Target Hame SE;':E;:;::EI Availability RE?::_EZSE Throughput
minzats.esrhp.com i, b p.c o my ara 18.09 502
minsats.esrhp.com LA TSN, GO My 985 25,38 385
winsats.esrhp.com athp.hp.com/! 1473 4.24
winsats.esrhp.com wan y3hoo.comd 19.52 424
minzats athp.hp.com/ 11.03 567
minzats g ydho o, comd 5487 12.69
Service Full Target Hame
ACME HTTM v, hp.comd
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AN NN NN

Service Level Violation Availability
g.0007 10071
= 1
85,4007 &0
= 1
= E a0t
54.800 E
(=
S 200l §
& =200
=
£ 201
= ]
= 1,600
-
0 Mow 03 [rac O3 Jan 04 Feb 04
MNow 03 Dec 03 Jan 04 Feb 04 .ﬁuailahili‘q.r
B sevice Level Wiolations .Unaxrailahili‘q.r
Response Time Throughput
ED.DD'/ s.007
24001 E 400t
1 = 1
@ 2
E 18.001 n 3.007
T T ____.——'—'_'__-
3 g
A 12.007 20aT
wn ]
1 & 1
6007 21007
In| + + | o + + |
Now O3 Lec 03 Jan 04 Feb 04 Mow 03 Lec 03 Jan 04 Feb 04
Forerage Fesponse Time FAuwerage Throughput
Maximun Response Time — Minimum Throughput
Response times displayed are the monthly average Throughput displayed are the monthhy awverage and
and maximum of the daily maximum hourly average. minimum of the daily minimum hourly averages.
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30 Day Services Detail inven:t

The 30 Day Services Detail Report presents performance statistics, calculated over the previous 30 days, for services associated
with a given customer. By selecting a paticular service, the user can see performance statistics for the probe and target
combinations that are part of the selected service. By selecting a probe and target combination, the daily service level violations,
availabilty, responze time and throughput for the selected test will be displayed far the preceding 30 days.

Customer
ACME
Internet Semices, Lid.
ek Manitaring Corp.
ForE, Incarparated

Service Parformance
Saorted by number of service level violations

Service Level

Service Violations Availability Rezponse Time Throughput
ACME HTTRA [ zm1ar | o7 = 17.72 461 -
ACME DHCP . z2ze 728 0.77 0.85
ACME HTTFZ 233 o7 2 12,04 4.20

ACME DNS 128 - @m0 0.40

WINSATS FTPR

65 R 154 114.00
ACME ODBE o

I [

Probe System / Target Performance Breakdown
Sorted by number of service level violations

Probe System Shu;:. ;a;get 5%‘:&;;5;&' Availability Response Time Throughput
winsats.esrhp.com v b coomy ar.0 16.50 4892
minsats. esr.hp.com R, TN . G o mys arz 24,45 284
minsats.esrhp.com athp.hp.com/! ar G 14.03 473
winzats athp.hp.camd oo 1076 553

Full Target Hame
una hp . cam/!
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Service Level Violation

- = 5] AN}
) o % [}
[} [} [}

Humber of Violation
[n]
[}

Feb 13 Feb 20 Feb 27 hdar 05
Bl sevice Level Vislations

Response Time
40,0071

32.007

Seconds
- [ x]
o B
o o
':.' [}

2.007

Feb 12 Feb 20 Feb 27 har s
tdax Hourly Awerage BT

Fesponse time displayed is the maximum haourly
awerage per day.

Availability

Percent

Feb 13 Feb 20 Feb 27 hdar 05

B v ail ability
B U avail ability
Threughput
7.007

T 5.60]

=] 4

]

& 4201

i

2

=201

a J

21401

0

Feb 12 Feb 20 Feb 27 har Qs
Min Hourly Average Throughput

Throughput displayed is the minimum hourly
Jwerage per day.
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Daily Services Detail invent

The Services Detail Report prezents performance statistics for services azsociated with a given customer for the selected day. By
zelecting a particular zervice, the uzer can zee performance statistics for the probe and target combinations that are part of the
zelected zervice, By zelecting a probe and target combination, the service level violations, availakility, responzse time and throughput
for the selected test will be displayed for the last 30 days .

Customer DE]F
ACME March &, 2004 i’
Internet Senices, Lid. harch 7, 2004
Web Manitoring Corp. March &, 2004
ZE, Incarporated March G, 2004 LI e

Service Performance
Sorted by number of service level violations

Service Level

Service Violations Availability Response Time Throughput
ACME HTTF1 s mes 1857 451 -
ACME DHCP w723 0.73 0.87
ACME DNS g [ dooom 0.95
WINSATS FTP 4 [ dooom 181 59.07
ACME HTTFZ z - 1506 47z
ACME ODBC o e =l

Probe System / Target Performance Breakdown
Sorted by number of senice level violations

Short Target Service Level I :
Probe System Hame Violations Auvailability Rezponse Time Throughput

winzats.esrhp.com L M. ¢ om/s _ _ 2993 421
winzats.esrhp.com v hpocams _ _ 17.52 437
winsats. esr.hp.com sthp-npcomi [NNESE [HEEET 16.08 4.90
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Availability

Service Level Violation

- - 5] [0}
) o % [
(] (] [}

Humber of Violation
[m1]
[}

Feb 13 Feb 20 Feb 27 hlar 05

@Daily Sewvice Lewvel Wiolations

Response Time

20007

24007

[ Y
ka0
[
e .= .
&7

Seconds

G.00T

Feb 13 Feb 20 Feb 27 har 05
hlax Hourly Awverage BT

Rezponse time dizsplayed is the max<imum hourly
Juerage per day.

b=

-1}

[ K]

[ =

[-1]

=

Feb 12 Febz0 Feb 27 Mar0s
B 2ovail ability
B unavailability
Throughput
5.007

—

T 4.00

=]

]

& a007

™

2

22001

[=4]

émn--

o

Feb 13 Feb 20 Feb 27 hdar 05
Min Hourly Awerage Throughput

Throughput displayed iz the minimum hourly
awerage per day.
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Monthly Services Detail
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The Zervices Detail Report prezents performance statistics for services azsociated with a given customer for the selected morth. By
zelecting a particular service, the user can zee perfarmance statistics for the probe and target combinations that are part of the

zelected service. By selecting a probe and target combination, the monthly service level violations, availakility, response time and
throughput for the selected test will be displayed for the preceding 12 months, Data for the current month covers results from the first
of the month through yvesterday.

cCustomer Month
ACME M arch, 2004
Internet Senvices, Lid. Februany, 2004
el Monitaring Corp. January, 2004
o, Incarporated Decembear, 20032

Service

ACME HTTF1
ACME DHCP
ACME DHNE
ACME HTTPZ
WINSATS FTF
ACME ODBC

Probe System

winsats.esrhp.com
winzats.esr.hp.com
winzats.esr.hp.com

winsath

Service Performance
Sorted by number of service level violations

Service Level
Violations

- Bmz 08 5 12,66
. Ew 724 0.7
58 S mo 0.55
26 og.4 19.52
23 Mo 166
[ B T R

Probe System / Target Performance Breakdown
Sorted by number of service level violations

Short Target Service Level o _
Hame Violations Availability ~ Response Time

wowhp.comi [ 7.0 12.00
wwnmsn.com!  [NEC 956 2538
IS e 1erm
D e s

athp.hp.com/!
athp.hp.com/

Availability Response Time Throughput

475
026

424
12457

Throughput

.0z
3.86
.24
5687

i

=l
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S.0007

1

Humber of Violation

5

SO0

Service Level Yiolation

Feb 04

Mow O3 Dec 03 Jan 04

@ Sewvice Lewvel Violations

Response Time

SD.DD'/
24.00¢
% 12 I:IIII:'
Z 12
= ]
[ X]
[:? 12007
g.0aT1
u| + + |
Mow 032 Lec 03 Jan 04 Feb 04

Aowerage Responze Time

“haximun Fesponse Time

Response times displayed are the monthly average
and maximum of the daily maximum hourly average.
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Availability
1007
g0t
= |
£ &0
o 1
&
a 7
201
o
Mow 032 Dec 03 Jdan 04 Feb 04
B svailability
B U availability
Throughput
E.DD}
E 400
(=] il
]
& z001
i I ———
=L}
200t
7]
@ 1
21007
o] + + |
Mow 03 Dec 032 Jdan 04 Feb 04

Awerage Throughput
— Minimum Throughput

Thraoughput displayed are the monthly average and
minimum of the daily minimum hourly awverages.
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Forecast Reports

The two reports in the forecast folder identify the services and probe types that are expected
to see their performance deteriorating at the fastest rates in the weeks and months ahead.
Use the forecast reports to spot:

e Probe types/services with the greatest rate of increase in service level violations
e Probe types/services with the greatest rate of increase in response time

e Probe types/services with the greatest rate of decrease in throughput

Forecast reports contain tables and charts. The tables perform the following functions:
e Calculate the 90-day forecast

e (Calculate the baseline average

e Sort items by the rate of growth

The graphs perform the following functions:

e Display 30-day, 60-day, and 90-day forecasts (forecast tab)

e Compare the baseline average to 30/60/90 forecasts (forecast tab)

e Show the data in the baseline that was used to generate the forecast (history tab)

See below for samples of the Probe Type Forecast and the Services Forecast.
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Probe Type Forecast invent

The Probe Type Forecast Report predicts future performance statistics for probe types associsted with & given customer bazed ok
the previous 30 davys of data. Each list of probe types is sorted by grestest rate of projected increaze (decreasze for throughput). By
zelecting a particular probe type, the user can zee the baseline average and 30, B0 and 90 day forecast of the metric, on the Farecast
tab and the data uzed to calculate the forecast on the History takb.

Custometr
ACME i‘
Internet Services, Ltd.
Web Manitoring Corp. ﬂ

Service Level Violations Forecast ] Histary |

Baseline 90 Day Projected Service Level Yiolations
Probe Type
Average Forecast 70
FTF Z2.20 6.0
w5h
[% DNS 6.27 14.63 =
242
DHCP 588 110.64 =
HTTF 845 05 1,128.10 o28
ICMP 000 0.00 = 1.4
(u]s]=]w 0.00 0.00 ]
O easeline Aorerage
O+z0 pays
(480 Days
[+a0 pays
Response Time Forecast | pistory |
Bazeline 90 D Projected Response Time
Probe Type W J P
Average Forecast a0
FTF 1.54 2.52 g
DNS 0.49 0.78 & ia
HTTF 17.70 25.24 5 -
o o1z
CHCF n7z 0.94 2
n]s]=1N 0.60
ICHFP 0.0z 0.0z a
Opaseline Furerage
O+z0 pays
[l+e0 pays
O+o0 pays
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Forecast ] Histary ]

Throughput
Baseline
Probe Type Average
DHS
oCBC
DHCF 08z
HTTP 4.52
ICMP 029
FTF 114.00

90 Day
Forecast

1.16
G132
0.50
207 .58

Bytes/Second

Projected Throughput
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Services Forecast invent

The Services Forecast Report predicts future perfarmance statistics for services associated with a given customer bazed on the
previous 30 days of data. Each list of services iz sorted by greatest rate of projected increase (decrease for throughput). By
zelecting a particular service, the user can see the baseline average and 30, B0 and 90 day forecast of the metric, on the Forecast tab
atidd the: data used to calculate the forecast on the Histary tab.

customer
ACME i‘
Internet Semvices, Ltd.
ek Monitaring Carp. ﬂ
Service Level Yiolations Forecast | History |
Service Baseline a0 Day Projected Service Level Yiolations
Average Forecast 70
MINSATS FTP 2.20 .02
w5
ACME DNS 6.27 1463 =
242
ACME HTTPZ 776 1148 =
ACME DHCF 75.88 110 54 Ez.e
ACME HTTFA 83522 1,116 62 1.4
ACME ICWP 0.00 0.00 ]
ACMWE ODBC o0.aa o.aao Ceazeline FPoarage
Smith DHCP 0.00 0.00 O+z0 pays
El+so pays
[l+o0 pays
. Fu:ureu:astl i
Response Time History |
. Baseline 90 Day Projected Response Time
Service
Average Forecast a0
WINSATS FTP 153 262 5a
ACME DHS 0.4a 07a L 1'8
ACME HTTP2 12.04 2843 5
L]
Smith DHCP 0.95 147 2 12
ACME HTTPAY 17.72 2426 0.60
ACME DHCP 077 1.02 ]
ACMWE QDBC DElaseIine Ararage
ACME IChMP 0.03 0.0z O+20 pays
El+a0 pays
Cl+a0 pays
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WWM

Farecast l Histary ]

Throughput
Service Baseline
Average
ACME DHS
ACME ODBC
Smith DHCF 0.57
ACME HTTFRZ 420
ACME DHCF 0.845
ACME HTTPRA1 461
ACMWE ICMP 0.z29
MWINSATS FTP 114.00

90 Day
Forecast

0.63
5.38
1.08
G.40
0.50
207 .52

BytesrSecond

Projected Throughput
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Editing Tables and Graphs

Any table or graph can be viewed in several ways. While the default view is usually adequate,
you can easily change to a different view. If you are using Report Viewer, right-click the object
to display a list of view options. If you are using the Web Access Server, follow these steps to
change the default view of a table or graph:

1

2
3
4
5

6

Click Preferences on the links bar.
Expand Reports in the navigation frame.
Click Viewing.

Select the Allow element editing box.

Click Apply.

Click # (the Edit icon) next to the table or graph.

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server,
opens a list of table view options.

Set Time Period, ..
Change Constraint values. ..
Seleck Modes/Interfaces. ..

Change Max Rows. ..

View in new Frame

Print Table, ..
Export Element as C3V..,

[Delete Table

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days
or to 7 days. If you are interested in a specific period of time that starts in the past and stops
before yesterday, click Use Absolute Time and select a Start Time and an End Time.
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View Options for Tables

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering
the number of elements that conform to the constraint. The Change Constraint Values
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node
Selection Type window opens.

Change Max Rows increases or decreases the number of rows in a table. The default is 50. If
you expand the default, the table may take more time to open. If you are trending a large
network, using the default ensures that the table opens as quickly as possible.

View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make
the data in the table more legible by resizing the window.

e

Direction
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input

Polled IP QoS Statistics Data - Input
Owver Previous 6 Hours

IpPrecedence Switched Bytes Switched Pkis Tirme Period

u] 105,688 G7TS Tue Oct 29 0700 A
Tue Oct 29 0700 Ak
Tue Oct 29 0700 Ahd
Tue Dot 29 0700 Ah
Tue Oct 20 07:00 Akt
Tue Dct 29 0700 Ahd
Tue Oct 29 0700 Ah
Tue Oct 29 0700 A
Tue Oct 29 0645 A
Tue Oct 29 06495 Ak
Tue Oct 29 05495 A
Tue Oct 29 06:45 A
Tue Oct 20 0645 A
Tue Oct 29 06495 A
Tue Oct 29 05495 A
Tue Oct 29 06:45 A
Tue Oct 29 0530 Ahk
Tue Oct 29 0530 A
Tue Dot 29 0630 Ak
Tue Oct 29 0530 Ak
Tue Oct 29 0530 Ak
Tue Dot 29 0530 A
Tue Oct 29 06:30 Ak
Tue Oct 29 0530 Ahk
20,744 64 Tue Oct 29 0515 A
Tue Dot 29 0615 Al
Tue Oct 29 05:15 Ak
Tue Dot 29 05:15 A
Tue Dot 29 0515 A
Tue Oct 29 06:15 Ak
Tue Oct 29 05:15 A
Tue Oct 29 0515 A
103,778 [ajdla] Tue Dot 29 0500 Ak

a a Tue Oct 29 06:00 Akt

{m Y I e R o

Goo

o th O O O O O

02,234 G2

o

[ T o Y Y Y o N e [

o7 630 G

o N e Y o

120

DADDDDD%DDDDDDD

= O - @™ th [ W ko= Ot R O~ ®m th s ka0 - @ th s R
o o o o o o O
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View Options for Graphs

Chapter 8

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server,
opens the following list of view options.

40900 1

22720 1

294540 1

16360 1

21.80 1

0

Add | Sverla. .

Remove Overlay

Set Time Period. ..
Zhange Constraint Yalues. ..

Seleck Modes/Interfaces. ..

Displayed Data

| arid
Legend
Skyle

- v v

Change Max Rows., .

Display Dakta Table
Export Element as C5Y, ..
Display: Cerlay Mata Table

Sep 17 Sep 21

Sep: o5 Sep: =0 Export Graph Swerlay Data as T,

View in new Frame

Print Graph. ..

[elete Graph

The following table provides details about each option.

Option

Function

Set Time Period

Same as the table option shown above.

Change Constraint Values

Same as the table option shown above.

Select Nodes/Interfaces

Same as the table option shown above.

Displayed Data For every point on a graph, display data in a
spreadsheet.
Grid Add these to the graph:
X axis grid lines
Y axis grid lines
X and Y axis grid lines
Legend Delete or reposition the legend.
Style See the illustrations below.
Change Max Rows... Same as the table option shown above.
Display Data Table See below.
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View Options for Graphs

Option Function

Export Element as CSV... Same as the table option shown above.
View in New Frame Opens graph in a Graph Viewer window.
Print Graph Same as the table option shown above.

Style Options

Select Style to display a list of seven view options for graphs.

[T

Set Time Period. ., 43 s

Change Canstraink Yalues., ..

Select Modes/Interfaces, .,

Displayed Data b % !
Grid ¥
Leqend ) A
| Skyle frea
Change Max Rows. .. Stacking Area
Cisplay Data Table Bar
Export Element as C5Y. .. Stacking Bar
Display: Grerlay Daka Table Pie:
Expart Graph @wverlay Daka as C54 ., # Plat
Wigw in new Frame Scatter Plok
Prink &raph. .. Airle N e
Delete Graph Hi-Lo-Open-Close —
- ~rom  Cande
Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are
easy to view in this format, absolute values for smaller data types may be hard to see. Click
anywhere within a band of color to display the exact value for that location

TrEaou +

9560

olurne

7170 1

Sat Feb 24 06:00 &AM EST
Mormal Disconnect (107 js 74.00

s

oA } } } } } } }
04:00 0E:00 0300 10:00 12:00 1400 16:00 1800 20:00 2200
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Chapter 8

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to
highlight the time span you want to focus on. Release the mouse button to display the selected
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a
small number of variables.

% 200.00

1E80.00
120.00
20.00

40.00

u]
hon 01 Tue 02 Wed 03

M g Utilization (H)
I 0 2 Utilization (Ha
M Util Threshold

Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values
for a small number of variables. There are three variables in the graph below.

14,924.00 -
9,539 .20
7,154.40

4,769 50

Forecast Minutes

2,364 80

Tho 01 Fri 0Z Sat 03 Sun 04 hon 05 Tue 06 ied OF
D=ys Of The Wieek
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View Options for Graphs

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame,
the time scale becomes hourly. If you increase the height of the frame, the call volume shows
in units of ten.

200.00
160.00
120.00
20.00
40.00

hon 01 Tue 02 Wead O3

M 2oeq Utilization (H)
I 1z Utilization ¢H)
M Uil Threshald

Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make
the data points align with hour; if you adjust the frame height, you can turn call volume into
whole numbers.

7850 1

E2.80 1 ﬂ
4710 1 [ M W

3140 1

1870 1

hon 01 Tue 02 Wed 03

— forg WMilization (H)
— hlax Utilization (H)
— Wil Threshald
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Chapter 8

Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the
pie constitutes a 24-hour period. This view is helpful when a small number of data values are
represented and you are looking at data for one day.

M Under 1 minute

[ Between 1 and & minutes

[ Between & and 30 minotes

O Between 20 minutes and 2 hours
M Between 2 hours and 12 hours
M Ohver 12 hours

If you are looking at data for more than one day, you will see multiple pie graphs, one for each
day.

Display Data Table

This option changes a graph into a spreadsheet.

(ol x]
X Axis I Average I

Tue Feb 19... 0,300

Tue Feb 19... 0.621

Tue Feb 19... 1.026

Tue Feb 19... 0.362

Tue Feb 19... 1.171

Tue Feb 19... 1.051

Tue Feb 19... 0.284

Tue Feb 19... 0.826

Tue Feb 19... 1.483 b\

Tue Feb 19... 0,967

Tue Feb 19... 1.471

Tue Feb 19... 1.308

Tue Feb 19... 1.123

Tue Feb 19... n.93

Tue Feb 19... 1.497

Tue Feb 19... 0,306

Tue Feb 19... 0.725
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View Options for Graphs

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window.

5 Graph Yiewer = 0| x|
Hetwaork Response Time
Cisco_04

Tue Feb 19 12:00 Ak - Tue Feb 19 11:00 P

Seconds

Tue 05:00 AM Tue 11:00 PM
— Awerage
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change max rows option, 55

customer-specific reports, 11

D

demo package, 12, 15
Display Data Table, 55
displayed data option, 55

distributed systems, 14
central server configuration, 21
defining OVIS collections, 14
installation overview, 14
satellite server configuration, 22

E
extracting packages from the distribution CD, 15

G

graph view options, 53
grid options, 55
group filters, 11

|
IR_DevPort_Hourly_Process.pro, 22

L

launching reports from NNM, 10
legend options, 55

N
Network Node Manager, 10

(o)
OVPI Timer, 16

R

report parameters, 12

S
style options for graphs, 55

T

table view options, 53

U
upgrading Common Property Tables, 14
Use Absolute Time, 53

\'

view in new frame, 54
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